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About this document

Version

4.0

Scope and purpose

The CAPSENSE™ Tuner is used to tune CAPSENSE™ applications.

Intended audience

This document helps application developers understand how to use the CAPSENSE™ Tuner as part of creating a
ModusToolbox™ application.

Document conventions

Convention Explanation
Bold Emphasizes heading levels, column headings, menus and sub-menus
Italics Denotes file names and paths.

Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets

Courier New

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions
The following define the abbreviations and terms used in this document:

e Application - One or more projects related to each other.

e CAPSENSE™- capacitive sensing

e Configurator - A GUI-based tool used to configure a resource.
e CSD - self-capacitance sensing method

e CSX-CAPSENSE™ Transmit/Receive (CAPSENSE™ with two electrodes: Tx and Rx), mutual capacitance
sensing method

e |IDE -integrated development environment

e MSCHW - A multi sensing converter, a hardware block - the latest hardware block, which supports the CSX
and CSD sensing methods.

e Peripheral - Any external analog or digital device that provides an input and output for the computer.
e PSoC™- programmable system-on-chip

e Widget - A CAPSENSE™ functional unit consisting of one sensor or a group of similar sensors, implementing
a specific higher-level functionality such as Button, Proximity Sensor, Linear Slider, Radial Slider, Matrix
Buttons or Touchpad.
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Reference documents

Refer to the following documents for more information as needed:

e Eclipse IDE for ModusToolbox™ user guide
e CAPSENSE™ Configurator guide

e Device Configurator guide

e PDL API reference guide

e Device datasheets

e Device technical reference manuals

user guide 20f34

(infineon

002-24353 Rev. *I
09-29-2021


http://www.cypress.com/mtbeclipseideuserguide
http://www.cypress.com/ModusToolboxCapSenseConfig
https://www.cypress.com/ModusToolboxDeviceConfig
https://cypresssemiconductorco.github.io/psoc6pdl/pdl_api_reference_manual/html/index.html

o~ _.
ModusToolbox™ |n f| neon
CAPSENSE™ Tuner guide

Table of contents

Table of contents

1 OVEIVIEW euuiruuirnenrsnsrasrsesssnssrssrsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 5
2 Launch the CAPSENSE™ TUNEK ..ccucieirerrecnerncressessecsssessesssssssssssssssssssssssssssssssssssssssssssssssssssssnsssss 6
2.1 From the Device CONFIGUIAtOr.......ccuieiiiereeteiereeeee ettt sttt ste ettt e e e ssa s e et e sae e s e sesnnessessesnnanns 6
2.2 MAKE COMMANG .ttt ettt ettt et ettt e et s b s b e b e b et et et e st sstesessessensensenseneenessens 7
2.3 ECLPSE IDE .oeeieeieeieeeiteete st et eteeste e st e steeste s te s be e baesbeessaeesaaesseenbaesbaesseesasaastesstasbaensaesssesssesnsesnsaensesnses 7
2.4 el =1 o1 (=N (€10 ) TSRS 8
2.5 From the COMMANA LINE .o..oiiiiiiieiieciecte ettt eteestessbe e sbe e sreesraesstesste s ba s baessaesnsesnsesnsasnsasses 8
3 QUICK STart. cuuiiieiiruiiraiiraenireiiraicrasssessssscrsesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssssss 9
4 GUI deSCrIPLION cuucruiirueiineiinnicrannsesireicrasrsessssssrsssrsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnses 11
4.1 MBIUS .. ettt ettt ettt e ettt e e ettt e e e ettt e e s e aateess s baeesssbaeessssaeesasssaeessssaeessssaeesssssaeesssnstaesessssnesenssneesns 11
4.2 TOOLDA ettt sttt et ettt b et b e bbb et et et ae s a e bbb e b et et et eneeneeseee 12
4.3 WAt EXPLOTEI PANE ...ttt ettt sttt s bt st et sat et e s st et et e st e be s st esbesaeentenbesanensans 13
4.4 Widget/SENSOr PAramMEters PANE....couiicieieeteieeteterte et sie st et st et et e st e be st ebesba s e e bessaesbesaeensensesasensens 14
4.5 TADS ettt sttt h e a b bbb et et e Rt e a e a e b e b et e b et et eneneeaeeseee 14
4.6 R = LU o - | USSR 15
5 Tuner COMMUNICAtION SETUP «.cucerierrerrerecenrerreceecacacrecsecescassassscsscassasssssssassassessscssssssssssssssassasse 16
6 Widget VIeW tab c.cvuiiuiiiiiiiiiiiiiiniiiniiiaecieiiniieesiniisecsesisscsestssssessssssscssssssssssssssssssssssssssssssssssanss 17
6.1 TOUCh SIgNAl Graph ...ttt ettt et e s st et e st e st e s st e besse e s e besanensans 17
6.2 TOOLDAT ettt ettt ettt b s bbb bttt et a s a e b b e b et et et et e st eneeseee 17
7 Graph VIeW tab....cccuieiiiiaiinnieiencenianioteecestastsssncscassssssssecsssssssssscsssassssssssssssssssssssssssasssssssssssssass 18
7.1 TOOLDA ettt ettt ettt et b st b e bbb et et et a e s h e b b e b et et et et e st eneeneee 18
7.2 Graph fUNCHIONALITY c..vecveeeeeeeeeeeeeeee ettt ettt et e e b e et e e e e b e e se et e ssaenbesbeersenseeseensenes 18
8 SNR Measurement tab ....cccccciiuiiiiieiiniinniaiiiiiiiiniisesiaiisstesiaisestesssessessasssessessssssessasssssssssascsnss 20
8.1 YAV 2o o € o =3 USRS 22
8.2 SNR MEASUIEMENT PrOCEAUIE.....ctieeeeieteeteteeeetee e ee e e e sre s e e s e tesseeaesse s s assesseessesseessensesssessensesseenes 23
9 TOUChPA VIEW taB o.cuieiiiiiiiiiiieeceiieninrecentesiossecscassssssssscassasssssscsssessssssssscsssssssssscssssssssssssssasss 24
9.1 TOOLDAN <ttt et st et s bt et et ea et s bt et e b e et et e e bt et e bt et e besaeentens 24
9.2 WO SEIECTION ...ttt ettt ettt st sb e b e sb et et ene s ne 24
9.3 DiSPLAY SETEINES .eueeeeeiieieeeetee ettt ettt ettt et ettt et sat et e b st et e e bt et e sat et e b e saeebesbeeabesaeentenees 24
9.4 SROW SIZNAL.. ettt ettt sttt ettt b bttt eneenes 25
9.5 TOUCKH FEPOIM ettt ettt et ettt et e s et et e st e st e s e sst e st esseessansesssensesseensesseensensesssensans 25
10  GeStUre VIeW tab c..cuiiuiieiiiiiiiiiiiieiiiieiiiieiiiieniiticseisciestessecassestessecssssssessessessssssssssssssssssssssssosass 26
10.1 TOOLDAN <ttt ettt et s bt et e b e a et e s bt et e b e et et e e bt et e bt et e besatetens 26
10.2 WAL SELECTION ..ttt ettt ettt et sb e ettt ea et e s st et e sbe et e be e bt et e saeeutesbesaeensens 26
10.3 L= o 1= o L= PP 26
10.4 GESTUIE IMONITO ...ttt ettt ettt et be e s st e st e st e s b e e beeeneeeneeemeesmeeemeeeneennees 27
10.5 GESTUIE EVENT NISTONY 1.ttt ettt ettt st e a st e b e sae et esbesanesesseeneenns 27
11  Tuner Configuration OPtiONS.....ccciiuiiiiiieiieiineiresiniiaesiesiaisestesisessestscsesrosssscssssassssssesssssssssassassse 28
user guide 30f34 002-24353 Rev. *|

09-29-2021



o _.
ModusToolbox™ In f| neon
CAPSENSE™ Tuner guide

Table of contents

11.1 DiSPLAY OPLIONS....uieteeeieieeeeteseetete ettt et e e et et e s e et e s se e st e sessees s e seeseesesseessesseensasesnsessassesnsenseensenses 28

11.2 SINR OPTIONS 1ttt ettt e s e s rbe e s s be e s ba e e sate e s baesssbeessbae e ssaesssaesssseesssaeessaasnsseesssaen 29

11.3 LOGEING OPTIONS...ciuiiriiiteiiteiiteereerte st sete st et e st e st e s sbessseessaesseesasesssesssessseesssesssesnsesssesssaensaeseessesssenas 29

12 TroubleShOOtING ..ccceuiiniiniiniiniinenienininesieiiaestesiascsestestsessestascssssesssscssssesssssssssssssssssssassssssassassne 30

B e T V1T 1T T o 1 T 1 -3 N 31
user guide 40f34 002-24353 Rev. *|

09-29-2021



ModusToolbox™ iﬁ“ eon

CAPSENSE™ Tuner guide
Overview

1 Overview

The CAPSENSE™ Tuner is a stand-alone tool included with the ModusToolbox™ software. The tool is used to
tune CAPSENSE™ applications.

Prior to using the CAPSENSE™ Tuner, create a CAPSENSE™ application and program it into the device. Refer to
the CAPSENSE ™ Configurator guide and the CAPSENSE™ middleware documentation for help. Your application
must contain the CAPSENSE™ Middleware and a communication interface (I*)C or UART). The Tuner works with
the KitProg3, MiniProg4, and UART devices.

Eile Edit View Communication Tools Help
ﬁ @ || j z 3 45" % Read mode: |Synchronized ~ M) v (M -

Widget Explorer (-4 Widget View Graph View SNR Measurement Touchpad View Gesture View

% B

- Butten0
Button0_Rx0

~ [ Buttent
Button1_Rx0
¥ [ LinearSliderd
LinearSliderd_SnsD
LinearSliderd_Sns1

LinearSliderD_Sns2
LinearSliderd_Sns3 Button1 300

LinearSliderD Snsd .I
Widget/Sensor Parameters 8 x

Name Value ~

¥ Widget general parameters

CZoomin @ Zoomout |[[FGraph /7 Cleargraph [ Save image
Buttonl Touch Signal Graph

200

Diplexing (3 false 100
Maximum position = 300
~ Widget hardware parameters
Finger capacitance (pF) 0.16
Sense clock divider = 10
Sense clock source (%) Auto (Direct)
Scan resolution & 126 o g 3 2 0z % T 3
Modulator IDAC (5 46 Dcl E‘ ;\ ;I ;I ;' gw
IDAC gain index (=) Index 4 - 2400... g g £ 2 2 £ =2
~ Widget threshold parameters @ @ z z z z Z
Finger threshold () 47 £ £ £ £ £
Noise threshold & 23 . e
Refresh rate: 21 pkis/s Bridge status: Connected Slave address: 0x08 12C clock: 400kHz  Supply voltage: 3206V Logging: OFF
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2 Launch the CAPSENSE™ Tuner

There are several ways to launch the CAPSENSE™ Tuner, and those ways depend on how you use the various
tools in ModusToolbox™. However, the easiest way is to launch it using the Device Configurator because the
CAPSENSE™ Tuner requires a properly configured CAPSENSE™ application programmed into the device. Refer
to the Device Configurator guide for more details.

2.1 From the Device Configurator

You can launch the CAPSENSE™ Tuner from the Device Configurator. Refer to the Device Configurator guide for
more details.

The process to launch the CAPSENSE™ Tuner from the Device Configurator differs slightly for device families
with the CSD hardware block and those with the MSC hardware block. There is only one resource for the CSD
hardware block, while there is more than one resource for the MSC hardware block.

1. Onthe Peripherals tab, select the CSD (CapSense) resource or the CapSense and one or more MSC
resources, as applicable for your device.

Peripherals  Pins  Analog-Routing  System  Peripheral-Clocks ~ DMA Peripherals | Pins  Analog-Routing  System  Peripheral-Clocks ~ DMA
Enter filter text... _g‘\f =l Enter filter tesxt..
Resource Name(s) Personali Resource Namels) Personality
Anslog Analog
c Cemmunication
.ommunlcatlun Digital
Digital v System
¥ System ~ [ CapSense ck_0| CapSense-1.0
5D (CapSense, etc.) 0 CYBSP_CSD C5D-2.0 TEED S ”
[ LCD Direct Drive 0 led_0_drive 0 MsC 1 MsC-11 -
[ Multi-Counter Watchdog Timer (MCWDT) 0 s [] LCD Direct Drive 0
[] Multi-Counter Watchdog Timer (MCWDT) 1 [ [] Watchdeg Counters (WDC)
[ Real Time Clock (RTC) [] Watchdog Timer (WDT)
2. Onthe Parameters pane, select an appropriate input Clock.
CSD (CapSense, etc.) 0 (CYBSP_CSD) - Parameters MSC 0 - Parameters
Enter filter text... &|o Enter filter text.. Al ]
Name Value Name Value
¥ Peripheral Documentation ~ Peripheral Documentation
(7) Configuration Help  Open C5D Documentation (7) Configuration Help Open MSC Documentation
v Inputs ~ Inputs
1@ Clock & © 16 bit Divider 0 clk [USED] | |7 Clock Signal & @ 16 bit Divider 0 clk [SHARED]
v CapSense ~ DMA connections
(7) Enable CapSense (7) Write DMAC Channel Trigger Output & (@ DMAC Channel 1 tr_out [USED]
(2) Target CPU core Cortex M4 (2) Chain Write DMAC Channel Trigger Input| & | @) DMAC Channel O tr_in [USED]
v External Tools =
. (7) Read DMAC Channel Trigger Output & O DMAC Channel 3 tr_out [USED]
(2) CapSense Configurator | Launch CapSense Configurator P ]
- (Z) Chain Read DMAC Channel Trigger Input | & @ DMAC Channel 2 tr_in [USED]
(7) CapSense Tuner Launch CapSense Tuner ~ External Capacitors
&)
« CSDADC Cmod1 & | @ P4[0] analog [SHARED]
(7) Enable CSDADC O () Cmed2 & @ P4{1] analog [SHARED]
v CSDIDAC v CapSense Sensors

3. Forthe MSC hardware block only, select the CapSense resource category on the Peripherals tab.

Peripherals Pins  Analog-Routing System Peripheral-Clocks DM

Enter filter text... Z|7
Resource Name(s) Personality
Analog
Communication
Digital
v System
v [~ CapSense CapSense-1.0
MSC 0 MSC-1.1 v
MSC 1 MSC-1.1 ~

[] LCD Direct Drive 0
[ Watchdog Counters (WDC)
[[] Watchdog Timer (WDT)
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4, Onthe Parameters pane, click the Launch CapSense Tuner button.

CSD (CapSense, etc.) 0 (CVBSP_CSD) - Parameters

CapSense - Parameters

Enter filter text...

5|9 |Emeu filter text...

Name Value
¥ Peripheral Documentation
() Configuration Help  Open CSD Dacumentation
~ Inputs
() Clock o | @ 16 bit Divider 0 clk [USED]
~ CapSense
(%) Enable CapSense
(7) Target CPU core Cortex M4

~ External Tools

(7) CapSense Configurator | Launch CapSense Canfigurator

'?\ CapSense Tuner Launch CapSense Tuner

Name Value
¥ Peripheral Documentation
')\ CapSense Middleware Open CapSense Middleware Documentation

(2) Configurstion Help  Open MSC Driver Documentatian
~ Extemal Tools

9\ CapSense Configurater | Launch CapSense Configurator

7\ CapSense Tuner Launch CapSense Tuner

2.2 make command

As described in the ModusToolbox™ user guide Build System chapter, you can run numerous make commands
in the application directory, such as launching the CAPSENSE™ Tuner. After you have created a ModusToolbox™

application, navigate to the application directory and type the following command in the appropriate bash
terminal window:

make open CY OPEN TYPE=capsense-tuner

This command opens the CAPSENSE™ Tuner GUI for the specific application in which you are working.

2.3 Eclipse IDE

If the selected application already includes a configuration (design.cycapsense) file, you can launch the
CAPSENSE™ Tuner from the Eclipse IDE. Right-click on the project in the Project Explorer and select
ModusToolbox™ > CapSense Tuner <version>. You can also click the CapSense Tuner link in the IDE Quick
Panel. Refer to the Eclipse IDE for ModusToolbox™ user guide and CAPSENSE™ Configurator guide for more

details.
9 Proj.. 2 % Deb.. 1 Regi.. Z Per. = O EQuick Pa.. (x)=Variables & Expressi.. ©g Breakpoi.
56 7 3
125 = Empty_PSoC4_App_1 [Empty_PSoC latest- .
125 > Hello_World [Hello World Istest-v2.% 3c56237] EC['Pse IDE for
i mib_shared ModusToolbox™
1= mtb_shared 2 (in mth_shared)
kﬁ* > mtw_beta3 (in M5C_CapSense C5D_Touchpad_Tun » Start
k‘é Mew >
kﬁ Tl » mitw_beta3 (CYSCKIT-0415-MAX)
=] » Launches
Open in New Window
Show In Alt+Shift+ W > 7 Tools
E ModusTeolbox™ > Library Manager 1.40 E Library Manager 1.40
< Show in Local Terminal > CapSense Configurator 4.0 E CapSense Configurator 4.0
Ea B Copy Ctrl+C CapSense Tuner 4.0 I (& CapSense Tuner 4.0 I
Note: These steps are the minimum required to launch the CAPSENSE™ Tuner. However, the Tuner will
not work without a properly configured CAPSENSE™ application programmed into the device.
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2.4 Executable (GUI)

You can launch the CAPSENSE™ Tuner GUI by running its executable as appropriate for your operating system
(for example, double-click it or select it using the Windows Start menu). By default, the CAPSENSE™ Tuner is

installed here:

<install_dir>/ModusToolbox/tools_<version>/capsense-configurator<version>

When run independently, the application opens without any information. You need to open a specific
CAPSENSE™ application configuration file that was created by the CAPSENSE™ Configurator for the Tuner to
work. See Menus for more information about opening a configuration file.

2.5 From the Command Line
You can run the Tuner from the command line. However, there are few reasons to do this in practice.

For information about the command-line options, run the Tuner using the —h option.
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3 Quick start

This section provides a simple workflow for how to use the CAPSENSE™ Tuner.

1. Create a CAPSENSE™ application with a tuner communication interface, and program the application
into the device. Refer to the Eclipse IDE for ModusToolbox™ user guide and the CAPSENSE™ Configurator
guide for more details.

Note: You can also use the PSoC 6 CapSense Buttons and Slider code example configured to work on PSoC™ 6
MCU kits or PSoC 4 MSC CapSense CSD Button Tuning to work on PSoC™ 4 MCU Kits.

2. Launch the CAPSENSE™ Tuner.

3. Start Communication. Click Connect and select the protocol. In this case - “I12C.”

Widget Explorer &2 X Widget View Graph View SMR Measures
% Bz ®
v Button0
Button0 Rx0 Ports: Port configuration
hd Button1 ~ KitProg3 UART-0A22091C02173400 12C address:
Button1_Rx0 12C
v LinearSliderD [ uarT Sub-address: | 2-Bytes ~
LinearSliderd_Sns0
LinearSlider_Sns1 Speed (ki) D =
LinearSliderD_Sns2
LinearSlider)_Sns3
LinearSlider]_Sns4
Port information
Interfaces: [2C UART
Firmware version: 2.30.1155
Protocol version: 2.3
Widget/Sensor Parameters
Name Cancel
~_Widaet |
Note: Refer to the KitProg user guide for supported configurations and modes. For this example, 12C

address, sub-address, and speed must match the configuration.
For the 12C communication, the Tuner only supports the 2-Bytes Sub-address.

5. Click Start to extract data.

|¢ OD b J E ‘E/.. E J Read mede: | Synchronized nv -

6. Touch the sensors on the hardware and notice the change in the sensor/widget status on Widget View Tab.

7. Open the Graph View tab. Check the sensors in the Widget Explorer Pane to observe sensor signals in the
graph. Touch the sensors and notice the signal change on the Graph View Tab.

8. Change widget/sensor parameter values as needed. Then, apply the new settings to the device using the
Apply to Device button.
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Tle Edt  View Communication Tools  Help
$0uE " HTS T ) readmose
Widget Explorer F X
o B
v Buttonl
Button(_Rx0
v Button!
Buttenl_Rx0
v [ LinearSliderd
LinearSliderD_SnsD
LinearSliderd_Sns1
LinearSliderD_Sns2
LinearSliderd_Sns3
LinearSliderD_Sns4
(Widget/Sensor Parameters F X
Name Value
~ Widget general parameters
Diplexing ) false
Maximum position = 300
~ Wi hardware parameters
Finger capacitance (pF) :
Sense clock divider ) 10
Sense clock source ) Aute (Direct
Scan resolution (% 12 bits
Madulator IDAC (= 46
IDAC gain index %) Index 4- 2400..
v Widget threshold parameters
Finger threshold (=) 47
Moise threshold =) 23
Negative neise thresheld 5 23
Low baseline reset % 30 v

Refresh rate: 21 pkts/s

Infineon

You can do this when using Manual or SmartSense (Hardware parameters only) modes for tuning:

o Toeditthe threshold parameters, use SmartSense (Hardware parameters only) mode.

e To editall the parameters, use Manual mode.

e When SmartSense (Full Auto-Tune) is selected for CSD tuning mode, parameters are read-only (except the
Finger Capacitance parameter).

9. Save the Tuner parameters. Click the Apply to Project button.

10. Exit the Tuner application.
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4 GUI description

The CAPSENSE™ Tuner application contains menus, a toolbar, panes, tabs, and a status bar, all used to tune a
CAPSENSE™ application.

W Q ™ ] : J E ,;, 'E‘ 5 Read mode:  Synchronized I - -

Widget Explorer F X Widget View  Graph View  SNR Measurement  Touchpad View Gesture View

e O

e O %ZOOI’HIH q\Zoom out ufGraph £ Clear graph [ Save image

v Button0 Touch Signal Graph
Button0_Rx0

- Buttonl

Button_RxD
4 LinearSliderd
LinearSlider_Sns0

LinearSlider0_Sns1
LinearSlider0_Sns2
LinearSlider)_Sns3 300
LinearSlider)_Sns4

Widget/Sensor Parameters F X
Name Value @
¥ Widget general parameters

Diplexing (2 false 100
Maximum pesition (2 200

~ Widget hardware parameters

Finger capacitance (pF) 0.76

ra
s

LinearSider o1 I

tinersicn 52

Sense clock divider =y 10
Sense clock source Y Auto (Direct
Scan resolution () 12 bits 3 3 3 % 3
Meodulator IDAC & 46 < 2 il g4
IDAC gain index (3 Index 4 - 2400... £ E 3 3 3
~ Widget threshold parameters = = ma ma ma
Finger threshold = a7 2 2 2
Moise threshold 7y 23 =
Refresh rate: 21 pkts/s Bridge status: Connected Slave address: 0x02 12C clock: 400kHz  Supply voltage: 3.296V  Logging: OFF
4.1 Menus
.
4.1.1 File

e Open... - Opens a <file_name>.cycapsense configuration file. This command is visible only when running
the Tuner independently from the Eclipse IDE.

e Apply to Device - Commits current values of a widget/sensor parameter to the device. This command
becomes active if a value of any configuration parameter from the Tuner application changes (that is, if the
parameter values in the Tuner and the device are different). This is an indication to apply the changed
parameter values to the device.

e Apply to Project - Commits current values of a widget / sensor parameter to the CAPSENSE™ project.

e Openin System Explorer - This opens your computer’s file explorer tool to the folder that contains the
*.modus file.

e Import... - Imports a specified configuration file.
e Export... - Exports the current configuration file into a specified file.
¢ Recent files - Shows recent files that you can open directly.

e Exit - Asks to save changes if there are any and closes the Tuner. Changes are saved to the configuration
file.

4.1.2 Edit

e Undo - Undoes the last action or sequence of actions.

e Redo - Redoes the last undone action or sequence of undone actions.
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4.1.3 View

o Widget Explorer - Hides or shows the Widget Explorer pane where widgets and sensors tree display.
o Widget/Sensor Parameters - Hides or shows the Widget/Sensor Parameters pane.

o Gesture Event History - Logs the detected gestures information. Displays in the View when any gesture is
available.

e Gesture Monitor - Provides visual indication for a detected gesture. Displays in the View when any gesture
is available

e Toolbar - Hides or shows the Toolbar. Enabled by default.

¢ Reset View - Resets the view to the default.

4.1.4 Communication

e Connect - Connects to the device via a communication channel selected in the Tuner Communication
Setup dialog. If the channel was not previously selected, the Tuner Communication dialog is shown.

¢ Disconnect - Closes the communication channel with the connected device.
e Start - Starts reading data from the device.

e Stop - Stops reading data from the device.

4.1.5 Tools
e Tuner Communication Setup... - Opens the configuration dialog to set up a communication channel with
the device.

e Options... - Opens the configuration dialog to set up different tuner preferences.

4.1.6 Help
e View Help - Opens the CAPSENSE™ Tuner guide (this document).

e About CapSense Tuner - Opens the About box to display the version information.

4.2 Toolbar

Contains frequently used buttons that duplicate the main menu items:

%]

o - Opens the configuration dialog to set up a communication channel with the device. The same
as the Tools > Tuner Communication Setup menu command.

J - Connects to the device via a communication channel selected in the Tuner Communication
Setup dialog. The same as the Communication > Connect menu command.

@ - Closes the communication channel with the connected device. The same as the
Communication > Disconnect menu command

. - Starts reading data from the device. The same as the Communication > Start menu command.

- Stops reading data from the device. The same as the Communication > Stop menu command.

= |

o L - Opens a configuration file. The same as the File > Open menu command.
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. Z - Commits current values of a widget/sensor parameter to the device. The same as the File >
Apply to Device menu command.

. E - Commits current values of a widget / sensor parameter to the CAPSENSE™ project. The same
as the File > Apply to Project menu command.

o« I - Imports a specified configuration file. The same as the Import menu command.

o = - Exports the current configuration file into a specified file. The same as the Export menu
command.

« = - Starts or stops data logging into a specified file.

e Read mode - Selects the Tuner communication mode with a device. The following options are available
(under the 12C communication interface):

e Synchronized - When selected, application firmware periodically calls a corresponding Tuner function:
Cy_CapSense_RunTuner(). The Tuner synchronizes data reading and firmware execution to preserve
data coherency. CAPSENSE™ middleware waits for the Tuner read/write operation to be completed
prior to execution of sensor scan and processing tasks. The Tuner does not read/write data until
CAPSENSE™ middleware completes scanning and data processing tasks for all widgets in the
application. The SNR and noise measurements are most accurate, and most tuning parameters can be
edited in real time updating in this mode.

e Asynchronized - When selected, the Tuner reads data asynchronously with sensor scanning and data
processing. Due to this, data coherency may be corrupted. So, the Tuner may read only partially
updated sensor data. For example, the device completed scanning of only the first sensor in a row. At
this moment, the Tuner reads data of the latest scan from the first sensor and data of previous scans
from the remaining sensor. This can occur to all sensors, when the Tuner reads data prior to the
completion of data processing tasks, such as baseline update and filter execution. SNR and noise
measurements are less accurate due to non-coherent data reading and only a limited set of tuning
parameters can be edited in real time in this mode.

. - Undoes the last action or sequence of actions. The same as the Edit > Undo menu command.

. ™ - Redoes the undone action or sequence of undone actions. The same as the Edit > Redo menu
command.

4.3 Widget Explorer pane

The Widget Explorer pane contains a tree of widgets and sensors used in the CAPSENSE™ application. You can
expand/collapse the Widget nodes to show/hide widget’s sensor nodes. You can check/uncheck individual
widgets and sensors in the Widget Explorer pane. The widget checked status affects its visibility in the Widget
View, while the sensor checked status controls the visibility of the sensor raw count / baseline / signal / status
graph series in the Graph View and signals in the Touch Signal Graph on the Widget View.

Selecting a widget or sensor in the Widget Explorer pane updates the selection in the Widget/Sensor
Parameters pane.

Note: For CSX widgets, the sensor tree displays individual nodes (Rx0_Tx0, Rx0_Tx1 ...) contrary to the
Configurator where the CSX electrodes are displayed (Rx0, Rx1 ... Tx0, Tx1 ...).
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4.4 Widget/Sensor parameters pane

The Widget/Sensor parameters pane displays the parameters of a widget or sensor selected in the Widget
Explorer tree. The grid is similar to the grid on the Widget Details tab in the CAPSENSE™ Configurator. The main
difference is that some parameters are available for modification in the Configurator, but not in the Tuner. This
pane includes the following parameters:

e Widget General Parameters - Cannot be modified from the Tuner because corresponding parameter values
reside in the application flash widget structures that cannot be modified at runtime.

e Widget Hardware Parameters - Cannot be modified for the CSD widgets when CSD tuning mode is set to
SmartSense (Full Auto-Tune) or SmartSense (Hardware parameters only) in the CAPSENSE™ Configurator.
In Manual tuning mode (for both CSD and CSX widgets), any change to Widget Hardware Parameters
requires hardware re-initialization performed only if the Tuner communicates with the device in
Synchronized mode.

e Widget Threshold Parameters - Cannot be modified for the CSD widgets when CSD tuning mode is set to
SmartSense (Full Auto-Tune) in the Configurator. In Manual tuning mode (for both CSD and CSX widgets),
threshold parameters are always writable (Synchronized mode is not required). The exception is the ON
debounce parameter that also requires hardware re-initialization (in the same way as the hardware
parameters).

e Sensor Parameters - Sensor-specific parameters. The Tuner application displays only IDAC values or/and
compensation IDAC value. The parameter is not present for the CSD widget when Enable Compensation
IDAC is disabled on the Configurator CSD Settings tab. When CSD Enable IDAC auto-calibration or/and CSX
Enable IDAC auto-calibration is enabled, the parameter is Read-only and displays the IDAC value as
calibrated by the firmware. When auto-calibration is disabled, the IDAC value entered in the CAPSENSE™
Configurator appears, and the parameter is writable in Synchronized mode.

e Filter Parameters and Centroid Parameters - Cannot be modified at runtime from the Tuner because,
unlike the other parameters, these parameter values reside in the application flash widget structures that
cannot be modified at runtime.

e Gesture Parameters - Synchronized communication mode must be selected to update the Gesture
parameters during runtime from the Tuner application.

Note: The position filter parameters, Adaptive IIR filter parameters, and Gesture parameters reflect data
stored in a loaded configuration file. Actual values may vary on a target device connected to the
CAPSENSE™ Tuner.

4.5 Tabs

The application consists of the following tabs:

e Widget View - Displays the widgets, their touch status, and the touch signal bar graph.
e Graph View - Displays the sensor data charts.

o SNR Measurement - Provides the SNR measurement functionality.

e Touchpad View - Displays the touchpad heatmap.
e Gesture View - Displays the Gesture operation.
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4.6 Status bar

The status bar at the bottom of the GUI displays information related to the communication state between the
Tuner and the device. Some sections differ depending on the communication type as follows:

4.6.1 I12C interface

|Refresh rate: 21 pkts/s Bridge status: Connected Slave address: (08 12C clock: 400kHz  Supply voltage: 3.295 V Logging: OFF
4.6.2 UART interface

|Refre5h rate: 42 pkts/s Bridge status: Connected Mode: Full duplex Baud rate: 115200 Supply voltage: 3.296 V Logging: OFF |

o Refresh rate - A count of read samples performed per second. The count depends on multiple factors: the
selected communication channel, communication speed, and amount of time for a single scan.

e Bridge status - Either Connected, when the communication channel is active, or Disconnected otherwise.
e Slave address - The address of the 12C slave configured for the current communication channel.

e 12C clock - The data rate used by the 12C communication channel.

e Supply voltage - The supply voltage.

e Mode

e Full duplex mode - Provides data transmission in two reverse directions: - target device > tuner- target
device. In this mode, you can change the parameters of the widgets / sensors at Run-time. To save the
new configuration, click the Apply to Device button

e Simplex mode - Provides data transmission in one direction: target device > tuner. In this mode, you
cannot change the parameters of the widgets / sensors at Run-time.

e Baudrate - The data rate at which CAPSENSE™ operates with the current settings.
e Logging - Either ON (when the data logging to a file in progress) or OFF.
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5 Tuner Communication Setup

The Tuner Communication Setup dialog is used to establish communication between the Tuner and target
device. The Tuner supports I12C and UART communication interfaces.

Ports: Port configuration Ports: Port configuration
v KitProg3 UART-0A22081C02179400 | 1a¢ address: v KitProg3 UART-0A22081C02179400 Baud rate: | 115200 -
12c [ 12c
[ UART Sub-address: | 2-Bytes ~ UART
Speed (kHz): | 400 b
Port informatien Port information
Interfaces: [2C UART Interfaces: 12C UART
Firmware version: 2.30.1155 Firmware version: 2.30.1155
Protocol version: 2.3 Protocol version: 2.3
Concel Cancel

Select Tools > Tuner Communication Setup... on the menu to open the dialog or click the Tuner
Communication Setup button. The dialog opens automatically after clicking the Connect button if no device
was previously selected.

Select the device and communication protocol by checking the item with the protocol name. Change the
protocol configuration parameters to match the configuration of the communication peripheral in the
application.

Note: The parameters in the Tuner Communication Setup dialog must be identical to the parameters of
the 12C or UART driver in the application.

Recommended - enable the UART Flow control on the target device for bitrates equal or higher
than 1000000.
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6 Widget View tab

The Widget View provides a visual representation of all widgets selected in the Widget Explorer Pane. If a
widget consists of more than one sensor, individual selected sensors are highlighted in the Widget Explorer
Pane and Widget/Sensor Parameters Pane.

Widget View Graph View SNR Measurement Touchpad View Gesture View
@, Zoomin @) Zoom out HF Graph gj Clear graph ] Save image

Touch Signal Graph

800

BBB 6DD

[
=)
=1

0

ButtonD_Rx0

LinearSlider0_sns0
LinearSlider_Sns1
LinearSlidero_Sns2
LinearSliderd_8ns3
LinearSliderd_Sns4

The Widget and/or sensors are highlighted when the device reports their touch status as active.

Some additional features are available depending on the widget type.

6.1 Touch Signal Graph

The Widget view also displays Touch Signal Graph. This graph contains a touch signal level for each sensor
selected in the Widget Explorer Pane.

6.2 Toolbar

The toolbar provides quick access to different Tuner configuration options that affect the Widget View display.

e Zoomin-Zooms in the widgets.

e Zoom out - Zooms out the widgets.

e Graph - Shows or hides the Touch Signal Graph.
e Clear graph - Clears the Touch Signal Graph.

e Saveimage - Opens the dialog to save the Widget View tab as an image. Supported formats: .PNG, .JPG,
BMP.
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7 Graph View tab

The Graph View displays graphs for the sensors selected in the Widget Explorer Pane.

Widget View  GraphView  SNRMeasurement  Touchpad View  Gesture View

Mumber of samples500_[¢]] 4 1egend | // Cleargraph [ZiSaveimage

=] Sensor Data

3500 — oo _————wvoo= [/ RawCount [V] Baseline
3000
2500
2000
1500

Button0_Rx0 RawCount ~
Button0_Rx0 Baseline
Button!_Rx0 RawCount
Button’ Rx) Bascline

=]

200
150

Button0_RxD DiffCount A
Button1_RxD DiffCount
B Linearsiiderd_Sns0 DiffCc
B LinearSiiderd Sns1 DiffCc
I LinearSlider0 Sns2 Diffcc ¥
>

Button0_Rx0 Status A
Button1_RxD Status

B LinearSliderd_SnsD Status

B Linearsiiderd_Sns1 Statue

I LinearSliderd Sns2 Status ¥

< >

LinearSliderD Position

100 200 300 400 500

Bridge status: Connected Slave address: 0x08 12C clock: 400 kHz Supply voltage: 3.295V. Logging: OFF

The following graphs are available:

e Sensor Data - Displays RawCount and Baseline. Click a corresponding check box to see them. Under Multi-
frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.

e Sensor Signal - Displays signal differences.

e Status - Displays a sensor status (Touch/No Touch).

e Position - Displays touch positions for the Linear Slider, Radial Slider, and Touchpad widgets.

7.1 Toolbar

The toolbar provides quick access to different Tuner configuration options that affect the Tuner graphs display.

e Number of samples - Defines the total amount of data samples shown on a single graph.
e Show/Hide legend - Shows or hides the sensor series descriptions (with names and colors) in graphs.
e Clear graph-Clears all graphs.

e Saveimage - Opens a dialog to save the Graph View tab as an image. Supported formats: .PNG, .JPG, .BMP.

7.2 Graph functionality

The Pan and Zoom features allow you to examine graphs in more detail. Use a mouse drag for Pan. Use the

mouse wheel for Zoom. The [Ctrl] key + mouse wheel zooms all graphs simultaneously. Press the [Esc] key to
undo zoom and pan.

If you click a sensor line series on the graph, the corresponding sensor series highlights on the legend pane.
Likewise, if you click a sensor series on the legend pane, it highlights a sensor line series on the graph. To
highlight lines for all graphs at the same time, press and hold the [Ctrl] key before clicking. To select multiple
sensors in the other Views, press and hold the [Alt] key while selecting the sensors.
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To change a sensor series color on the legend pane, double-click it. The “Please choose a color for ...” dialog
displays.

Basic colors

EEEEEENT
EEEEEENC]
EEEEENNC]
EEEEEENC]
EEEEEEEC]

| Pick Screen Color |

Hue: 224 '3 Red:
Sat: (228 |3 Green:
val: (113 |3  Blue:

Custom colors

N I O R
l:l l:l I:l I:l I:l I:l I:l I:l Alpha channel:
Add to Custom Colors HTML:
Cancel

Select a color and click OK. To select a color for all the graphs at the same time, press and hold the [Ctrl] key
while clicking.
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8 SNR Measurement tab

The SNR Measurement tab allows measuring a SNR (Signal-to-Noise Ratio) for individual sensors. It provides
the user interface to acquire noise and signal separately and then calculates a SNR based on the captured data.
The obtained value is then validated by a comparison with the required minimum (5 by default, can be
configured in the Options dialog).

Widget View  Graph View = SNR Measurement  Touchpad View  Gesture View

if|egend ¢\ Spike /- Clear [ Saveimage

Button(_Rx0 Acquire Noise Acquire Signal Result:PASS

The signal measurement is complete.

MNeise: 15.00 Signal: 338 SNR: 22.54
Q
1550 oD © O o - g
MNoise
Qo Signal
1500 @] < MoiseSpike
O SignalSpike

14350
o 1400
£
E]
El
v}
:
= 1350
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1250

QP @, G !
1200 :‘m‘fp,-.JH.‘J_u;),-»a"uwea.‘?lﬁw-_-.,.;,ﬂ,.';.'a,@j\.:ﬁﬁ,-,u'.-',if#@@ﬁ'%'@gr%faw
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The SNR Measurement tab contains several areas, as follows.

At the top of the SNR measurement tab, there is a bar with the status labels. Each label status is defined by its
background color.

e Select sensor - Green when there is a sensor selected; gray otherwise.

e Acquire noise - Green when noise samples are already collected for the selected sensor; gray otherwise.

e Acquire signal - Green when signal samples are already collected for the selected sensor; gray otherwise.

e Validate SNR - Green when both noise and signal samples are collected, and the SNRis above the valid
limit; red when the SNR is below the valid limit, and gray when either noise or signal are not yet collected.

Below the top status labels bar, there are the following controls.

LinearSlider0_Sns1 Acquire Moise Acquire Signal Result:PASS

e Sensor name - The sensor selected in the Widget Explorer Pane or None (if no sensor selected).
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e Acquire Noise - This button is disabled when no sensor is selected or communication is not started. When
acquiring noise is in progress, clicking the button aborts the operation.

e Acquire Signal - This button is disabled when no sensor is selected, communication is not started, or noise
samples are not yet collected for the selected sensor. When acquiring signal is in progress, clicking the
button aborts the operation.

e Result - This label shows either N/A (when the SNR cannot be calculated due to noise/signal samples not
collected yet), PASS (when the SNR is above the required limit), or FAIL (when the SNR is below the required
limit).

Below the controls bar, there is the current status message and the progress of the current operation. Below
the progress bar, there are three labels:

The signal measurement is complete.

Moise: 21.00 Signal: 823 SMR: 39,19

e Noise - Shows the last measured noise average value for the selected sensor, or N/A if no noise
measurement is performed yet.

e Signal - Shows the last measured signal average value for the selected sensor, or N/A if no signal
measurement is performed yet.

e SNR-Shows the calculated SNR value. This is the result of the Signal/Noise division rounded up to 2
decimal points. When an SNR cannot be calculated, N/A is displayed instead.
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At the bottom, there is a chart that displays the measured sensor noise and signal. Noise and signal spikes
displayed on the chart are points ignored during SNR calculation.

1550 R © O o]
Moise

o Signal
1500 o O MoiseSpike

O SignalSpike

RawCount

8.1 SNR options

SNR parameters can be modified in the options dialog. See Tuner Configuration Options for descriptions of
other tabs on this dialog.

Display SHNR Logging
Noise sample count:
Signal sample count:
SMR pass value:
Ignore spike limit: 4 =
Noise calculation method:  Peak-to-peak >
Progress bar text mode:  Hide ~
[] signal graph below noise
Show spike points
Show legend
Restore Defaults oK Apply

e Noise sample count - The count of samples to acquire during the noise measurement operation.
e Signal sample count - The count of samples to acquire during the signal measurement operation.
e SNRpass value - The minimal acceptable value of the SNR.

e Ignore spike limit - Ignores a specified number of the highest and the lowest spikes at noise / signal
calculation. That s, if you specify number 3, then three upper and three lower raw counts are ignored
separately for the noise calculation and for the signal calculation.

e Noise calculation method - Allows selecting the method to calculate the noise average. The following
methods are available for selection:

o Peak-to-peak (by default) - Calculates noise as a difference between the maximum and minimum value
collected during the noise measurement.

e RMS - Calculates noise as a root mean-square of all samples collected during the noise measurement.
e Progress bar text mode - This label is shown with the progress bar:
e Hide (by default) - No label.

e Percent - The number of samples in percent acquired during the signal measurement operation.

user guide 22 of 34 002-24353 Rev. *|
09-29-2021



o~ _.
ModusToolbox™ |n f| neon
CAPSENSE™ Tuner guide

SNR Measurement tab

e Value - The number of samples acquired during the signal measurement operation.
e Signal graph below noise - Displays the signal series below the noise threshold on the graph.
e Show spike points - Highlights the spike points on the graph.
e Show legend - Shows the graph legend.

8.2 SNR Measurement procedure
1. Connect to the device and start communication (by pressing Connect, then Start on the toolbar).
2. Switch to the SNR Measurement tab.
3. Select asensor by clicking it in the Widget Explorer Pane.
4. Ensure no touch is present on the selected sensor.
5. Press Acquire Noise and wait for the required count of samples to be collected.
6. Observe the Noise label is updated with the calculated noise average value.
7. Touch the selected sensor to produce signal on it.
8. Press Acquire Signal and wait for the required count of samples to be collected.
9. Observe the Signal label is updated with the calculated signal average value.

10. Observe the SNR label is updated with the SNR (signal-to-noise ratio.
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9 Touchpad View tab

This tab visually represents signals and positions of a selected touchpad widget in the heatmap form. Only one
CSD and one CSX touchpad can be displayed at a time.

Note: The Touchpad View tab is disabled when there are no touchpad widgets in the configuration.
WidgetView  GraphView  SNRMeasurement  Touchpad View | Gesture Viey
@, Zoomin @, zoomout . Clear [ Save image
Widget selection
€sD: |Touchpada | csx: [Touchpadt -
[ Fiip X-axis [ Fiip X-axis
[ Fiip Y-axis [ Fiip Y-axis
[ swap XY-axes [ swap X¥-axes
Display settings
Display mode: Touch reporting v
Data type: Diff count v
Value type: Current v
Number of samples: 100
Show signal
- Display touch position: | Display both -
Color range:
— Min: 0 3 Mncolor.. [
| | | | | | | Max: 300 3 Maxcolor... | [l
Touch report
CSD touches
Touch# X ¥
¥ touches
D X ¥ z
9.1 Toolbar

e Zoomin-Zooms in the Touchpad widget.
e Zoom out - Zooms out the Touchpad widget.
o Clear - Clears the touchpad.

e Saveimage - Opens a dialog to save the Touchpad View tab as an image. Supported formats: .PNG, .JPG,
.BMP.

9.2 Widget selection

Consists of the configuration options for mapping the physical touchpad orientation to the identical
representation in the heatmap:

e CSD combo box - Selects any CSD touchpad to display in the heatmap.

e (CSXcombo box - Selects any CSX touchpad to display in the heatmap.

e Flip X-axis - Flips the displayed X-axis to match the orientation of a physical touchpad.

e Flip Y-axis - Flips the displayed Y-axis to match the orientation of a physical touchpad.

e Swap XY-axes - Swaps the X- and Y-axes for the touchpad.

9.3 Display settings

Manages heatmap data to display. These options are applicable for the CSX touchpad only.
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e Display mode - The drop-down menu with 3 options for the display format:
e Touch reporting - Shows current detected touches only.
e Linedrawing - Joins the previous and current touches in a continuous line.
e Touch Traces - Plots all the reported touches as dots.

o Datatype - The drop-down menu to select the signal type to display: Diff count, RawCount, and Baseline.
Under Multi-frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.

e Value type - The drop-down menu to select the type of a value to display:
e Current - The last received value.
e Max hold - The maximum value out of latest “Number of samples” received.
e Min hold - The minimum value out of latest “Number of samples” received.
e Max-Min - The difference between maximum and minimum values.
e Average - The average value of latest “Number of samples” received.

e Number of samples - Defines a length of history of data for the Line Drawing, Touch Traces, Max hold, Min
hold, Max-Min, and Average options.

9.4 Show signal

Enables displaying data for each sensor if checked, otherwise displays only touches. This option is applicable
for the CSX touchpad only.

o Display touch position - Selects the touchpad from which data is displayed in the heatmap. The three
options:
o Display only CSX
e Display only CSD
e Display both

e Colorrange - Defines a range of sensor signals within which the color gradient is applied. If a sensor signal
is outside the range, a sensor color is either minimum or maximum out of the available color palette.

9.5 Touch report

e CSDtouches table - Displays the current X and Y touch position (Z value is always 0) of the detected
touches on the CSD touchpad. If the CSD touchpad is neither configured nor touch is detected, the touch
table is empty. When two-finger detection is enabled for a CSD touchpad, then two touch positions are
reported.

e (CSXtouches table - Displays the current X and Y touch position and Z values (amplitude) of the detected
touches on the CSX touchpad. If the CSX touchpad is neither configured nor touches is detected, the touch
table is empty. The middleware supports simultaneous detection up to three touches for a CSX touchpad
touch, so the touch table displays all the detected touches.
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10 Gesture View tab

This tab visually represents evaluation and tuning of gestures (from one widget at a time).

Note: The Gesture View tab is disabled when there is no gesture widget in the configuration.
‘Widget Explorer 8 x Widget View  GraphView  SNR Measurement  Touchpad View  Gesture View
B 7 Openimage U3 Reset position | Save image Widget selection
v [ Touchpad! ~ Touchpad1 ~
R Dt xous
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B} o ot O suap¥axs

[ Touchpadi_Rx0_Te5
[ Touchpad_Rx0_T6
[ Touchpad_Rx0_T&7
O Touchpad1_Rx0_T&
[ Touchpad?_Rx0_Ted
] Touchnad] Rl Tuh

o _.
_EEE - Infineon
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Note: Synchronized communication mode or UART communication is recommended for Gesture
validation, to make sure no gesture event such as a touchdown or lift-off is missed during
communication.

10.1 Toolbar

e Openimage - Opens a custom image.
e Reset position - Resets the image position and zoom. The image is moved to the center of the panel.

e Saveimage - Opens a dialog to save the Gesture View tab as an image. Supported formats: .PNG, .JPG,
.BMP.

10.2 Widget selection

Allows selecting a widget and controls that the display in the Tuner matches the orientation physical widget on
hardware.

e Combo box - Selects the widget with Gesture enabled to display the Gesture from it on this pane.

e Flip X-axis - Flips the direction of the X-axis to match the orientation of a physical widget.

e Flip Y-axis - Flips the direction of the Y-axis to match orientation of a physical widget.

e Swap XY-axes - Swaps the X- and Y-axes to match orientation of a physical widget.

10.3 Image pane

An image reacts to the detected gestures (scroll and zoom) and moves around the pane. You can change the
image by clicking the Open image tool button.
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10.4 Gesture Monitor

Provides visual indication for a detected gesture.

Gesture Monitor
Detected gesture

Delay (ms): 1000 |3

@
@
-

One-finger Single  One-finger Double  One-finger Click and  Two-finger Single
Click. Click.

Drag Click. One-finger Scroll  Two-finger Scroll

e |17

One-finger Edge
Swipe

One-finger Rotate  Two-finger Zoom Touch Down Lift Off

@ﬁfoo

If the Delay checkbox is enabled, a Gesture picture is displayed only for the specified time-interval. If disabled,
the last reported gesture picture is displayed until a new Gesture is reported.

10.5 Gesture Event history

Logs the detected gestures information.

@ 7
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16:45:03.005, Widget: Touchpadi,

16:45:03.126, Widget: Touchpadi,
16:45:03.564, Widget: Touchpadi,
16:45:03.662, Widget: Touchpadi,
16:45:03.760, Widget: Touchpad?,
16:45:03.867, Widget: Touchpad?,
16:45:03.861, Widget: Touchpadl,
16:45:04.419, Widget: Touchpadi,
16:43:04.518, Widget: Touchpadi,
16:43:04.838, Widget: Touchpadi,
16:45:05.275, Widget: Touchpadi,
16:45:05.605, Widget: Touchpadi,

T T S T GO T, DTS S T T TV, TS T s, ST
Fingers: 1, Gesture: One-finger Scroll, Direction: Left, Pesition: (154, 381),
Fingers: 1, Gesture: One-finger Scroll, Direction: Left, Pesition: (124, 362),
Fingers: 1, Gesture: One-finger Scroll, Direction: Right, Pesition: (349, 400),
Fingers: 1, Gesture: One-finger Scroll, Direction: Right, Position: (480, 395),
Fingers: 1, Gesture: One-finger Scroll, Direction: Right, Pesition: (589, 391),
Fingers: 0, Gesture: One-finger Flick, Direction: Down Right, Position:

Fingers: 0, Gesture: Lift Off, Direction: Mone, Position:

Fingers: 1, Gesture: Touch Down, Direction: Mone, Position: (681, 743),

Fingers: 2, Gesture: Touch Down, Direction: Mone, Pesition: (398, 888), (611, 160),

Fingers: 2, Gesture: Two-finger Scroll, Direction: Left, Position: (417, 839), (474, 144),
Fingers: 2, Gesture: Two-finger Scroll, Direction: Left, Position: (401, 871), (419, 133),

Fingers: 0, Gesture: Lift Off, Direction: Mone, Position:
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11

Tuner Configuration options

(infineon

The Tuner application allows setting different configuration options with the options dialog. The settings are
divided into groups:

11.1

Display options

Theme: |Light

\\\\\\\\\\\\\\\\\

11.1.1

Theme

Defines the visual style of widgets.

Theme
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11.2 SNR options

Display SNR Logging

Noise sample count:
Signal sample count:
SNR pass value:
Ignore spike limit:

Noise calculation method:  Peak-to-peak ~

Progress bar text mode:  Hide ~
I:‘ Signal graph below noise

Show spike points

Show legend

Restore Defaults oK Apply

See the SNR options section for a description of this tab.

11.3 Logging options

Display ~ SNR Logging

Log file: | |

[] Append log to an existing file

Mumber of samples: m Repeat header after number of samples: “

Mame RawCour Baseline DiffCour Status  WogtStat, Position
O O O O O O
v [] ButtonD O
[ Button0_Rx0 O O O O
w [] Buttonl |
[ Butteni_RxD O O O O
v [ LinearSliderd O O
[ LinearSliderd_Snsd [] O a O
[ LinearSliderd_Sns1 [] O O O
[ LinearSliderd_Sns2 [] O O O
|:| LinearSlider)_Snz3 |:| |:| |:| D
[ LinearSliderd_Snsd| [] O O O
Restore Defaults Cancel Apply

e Logfile - Selects a csv file and its location to store information.

Infineon

e Append logto an existing file - If this option is enabled, the selected file cannot be overwritten and
expanded with new data. When this option is not enabled, the selected file can be overwritten.

e Number of samples - Defines a log session duration in samples. The header is repeated after a number of

samples.

e Data configuration check box table - Selects data to collect into a log file.
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12

Troubleshooting

Problem

Workaround

On common Linux distributions, the serial
UART ports (usually /dev/ttySx or
/dev/ttyUSBx devices) belongs to the root
user and to the dialout group. Standard
users are not allowed to access these
devices.

An easy way to allow the current user access to the Linux machine's serial
ports is by adding the user to the dialout group. This can be done using the
following command:

$sudo usermod -a -G dialout S$USER

Note: For this command to take effect, you must log out and

then log back in.

On Linux, attempts to set up or start the
CAPSENSE™ Tuner communication leads
to the Tuner closing without any
messages.

To enable Tuner communication under Linux, install the udev rules for
KitProg3:

Disconnect the KitProg device.

Execute in the terminal (root access required):

sh S$CYSDK/tools/fw-
loader/udev_rules/install rules.sh

Reconnect the KitProg device.

On macOS, the CAPSENSE™ Tuner can't be
launched from the Launchpad.

Launch the Tuner from within the Device Configurator or use the
command line option.

On common Linux distributions, the Tuner
forbids communication protocol selection
after re-plugging KitProg during
communication.

Refer to the “Installation Procedure on Ubuntu Linux (x64)” section in the
Cypress Programmer 2.1 CLI User Guide.

KitProg3 UART is accessible but not able to
read data on Linux kernel 4.15 and above
or Mac 0S X 10.13 and above.

Use third-party UART to USB bridge.
Update the KitProg3 firmware to version 1.11.243 or above.

Note:

The Tuner provides information about the root cause of connection to KitProg in an operation log.

The operation log location can be found in the About CapSense Tuner dialog.
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13 Version changes

This section lists and describes the changes for each version of this tool.

Version Change descriptions
1.0 New tool.
Added UART interface.

Added possibility to save different views as images.

11
Added zoom and pan functionality for graphs.

Fixed minor issues.

Added "IDAC gain index" parameter.
Changed the data storage location from a header (.h) file to an XML-based *.cycapsense file.

For backward compatibility, the configurator is still able to load the header (.h) file that contains the
legacy format configuration. But, if the legacy header (.h) with the configuration is passed via a
command-line parameter, a message appears saying that the .h file is not supported.

Added the Import and Export options to the File menu that enable importing and exporting the
configuration file from and into the external file.

Added the Reset View command to the View menu that resets the view to the default.
Added Multi-frequency support that enables selecting RawCount and Baseline.
2.0 Added the UART option description in Status Bar.

Changed generation of the middleware initialization structure according to the changes in CapSense
v2.0 middleware (related to added fields for flash memory optimization, fixed defect with RawCount
filters config, IDAC gain index, etc.).

Added support for selecting multiple sensors in some view and reflecting the selection in other views.
Added handling of invalid command line arguments.

Added highlighting of modified properties in the property grid with bold.

Added a warning if opening a broken configuration file.

Fixed memory leaks.

Fixed Graph View issues under high load of application.

Added the Undo / Redo feature.

3.0 Changed the list of UART baud-rate possible values to match the values supported by KitProg. The
highest rate is 3000000.

Updated versioning to support patches.

Added a popup notification when the Apply to device command completes.

Increased the communication speed between the device and Tuner when using the 12C interface.

319 Improved the tool performance for loading large configurations.
Fixed the issue with applying changes to the device when using the UART communication interface:
now, many changes (>16) are applied correctly.
3.11 Updated versioning to support the updated backend, for detail, see Device Configurator user guide.
3.15 Removed from the GUI the possibility to change several UART settings (data bits, stop bits, parity) in
order to match KitProg-supported values. The values used: data bits = 8, stop bits = 1, parity = none.
Optimized the 12C interface communication to increase the speed.
Added support for the PSoC 4100S Max family.
Added support for the CAPSENSE™ Middleware Library 3.0.
4.0 Added a CSX touchpad sensor status display on the Graph view.
Logging data from the device: removed the header duplication from the bottom of the pages of the
file.
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Version Change descriptions
Changed the operation log file location. The new location can be found in the About CapSense Tuner

dialog.
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Revision history

Revision Date Description

** 11/26/2018 New doc.

*A 12/05/2018 Documents were updated with changes requested in BVI-353.
*B 02/26/2019 Updated to version 1.1.

*C 10/16/2019 Updated to version 2.0.

*D 11/01/2019 Added section for launching from Device Configurator.

*E 03/27/2020 Updated to version 3.0.

*F 09/01/2020 Updated to version 3.10.

*G 12/14/2020 Updated to version 3.11.

*H 03/11/2021 Updated to version 3.15.

*| 09/29/2021 Updated to version 4.0.
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